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easyBoard – First steps and creation of a first planogram 
 

Start and Login 
On your screen you should see a small icon named easyBoard. 

 
 
Double-click on this icon and easyBoard starts. 
 
 
 

You will then see the login dialog. 

 

Here the connection to the internal service and to the database is already preset (line service 
address). For user name and password, you will be given predefined entries or they will already be 
predefined. The check mark at Remember user name and password ensures that you do not have to 
make these entries again the next time you start the program. 

Then click on the Login button and easyBoard will start. 

You will briefly see the start screen...... 

 
....and shortly afterwards you are already in easyBoard. 
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Main window with individual work areas 

After easyBoard has started, you are in the main window of easyBoard. This is divided into six main 
areas, which are described in the following screen. 

Menu bar: 

It contains the individual work areas with the respective functions and shows the corresponding 
buttons (toolbar for DeepL access) of the functions.  

Search window: 

This is where you search for products or product carriers / shelf parts in order to always have the 
right one available from your article master in a matter of seconds. 

Libraries: 

All products and product carriers are clearly sorted into so-called libraries. You determine the 
content and the sorting. Libraries can be e.g. also commodity group designations. 

Status bar: 

A small info area that always shows the current status of a selected object. For example, if you click 
on a placed product, the article number and description will be displayed here. The same applies if 
you click on a shelf in the rack with the mouse, for example. 

2D / 3D workspace: 

This is where your planogram will be created later and will show products, shelves, pallets in 
progress both in 2D and always in 3D. 
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Your first project 
 
New project 

So that you can work efficiently and without frustration right from the start when working with 
easyBoard, we will go through a sample project with you below. 

Please click on the Project tab in the menu bar at the top left. 

 
 

A menu opens. 

Click here on the entry New, which stands for the creation of a new project / planogram in 
easyBoard. 

 

After clicking on 'New', a small dialog box appears in which you can enter the information 
required for the new project. Attention: You must enter something in all fields that have a 
small red star next to the name. All fields without this red star do not require any input. 
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In your case we only need the input of any 
project name. 

Please avoid the use of special characters like 
commas or slashes from the beginning. If you 
want to output the project as a PDF or in 
another format at a later time and save it on 
your computer or server drive, Windows will 
acknowledge this with a refusal and error 
message if you use such special characters. 
Slashes (/) are used by Windows to separate a 
folder from a subfolder and not to specify a file 
name. 

In addition to the project data, the new project 
creation window has two more tabs at the top. 

 
Behind this are options for selecting and 
entering further individual data for your project. 
For example, you can use an additional module 
(please ask your easyBoard representative or 
easyBoard support) to predefine your own 
tables and assign their contents to the project in 

the simplest way. Individual fields can also be created and your data can then be entered into them 
when they are created or at a later date. 
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Back to our first project window:  
If you have entered the project name, you can still 
specify from here where, in which folder, a project 
is filed and saved.  

If the system is still virgin, the Root folder will be 
available as the storage location for the time being.  

Go to the Project tab in the menu bar, then click on 
the Open button. 

Now the Project Manager window opens. 

There you have the possibility to create subfolders. 

After the project name and the storage location 
have been determined, you can finally start: Click 
on the Open button and the current window closes. 

Now your first project is created and waiting to be 
filled with life, respectively products and shelf 
parts. 

If you take a look to the left and look at the 
libraries, you may notice that the view has changed. Instead of the usual products being displayed 
there, you will now see the possible product carriers / shelf parts. 
 
easyBoard knows that this is a completely new project and nothing has been placed or planned yet.  

Your next task is to assemble the shelf to be planned in its basic form. 

The small tabs above the library entries always show you where you are: 

  
The symbol for products:  
You will find it equally at other   
places in the program when it comes to product data: 

 

  
 

The symbol for goods carriers and shelf parts: 
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Now go back to the libraries for merchandise supports. 

easyBoard works in principle as if you were assembling a shelf in your sample room.  

I.e. first the columns for the first unit, then the back panels, then the shelves, etc. 

Let's assume in our example that we want to create a Tego shelf with 2 units 125 width and 200cm 
height. 
 

 

If you now click on the 1- Tegometall Standard entry in the container library, this library will open 
and you will see further entries, which in turn can be opened or closed by double-clicking and thus 
display the contents.  

- In the entry 'Columns' you will find the stands or columns in the available sizes.  

- In the entry 'Back panels' you will find the available types of back panels (perforated and smooth)  

- In the entry 'Shelves' you will find all available widths and depths of shelves.  

  

So we have everything we need for a standard shelf with dimensions 2x125cmx200cm.  

Double click to open the library Columns/Uprights 80x30. Then double click on the second entry from 
the top, which contains the columns in a height of 200cm. 
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After double-clicking, you will see the column placed in the center of your screen. 
 

 

Next it's the turn of column no. 2, which has to be placed exactly at a distance of 125cm. 

Place columns 
So that you do not have to do this awkwardly by pushing and pulling with the mouse, easyBoard 
offers a clever assistant, the so-called distance manager. 

The spacing manager is visible at the top of 
the libraries. If you click there on the now still 
empty entry, various distance types will 
appear that we have already integrated for 
you (by the way, you can add as many of your 
own as you like).   
Please click on the entry Tego 125 in the list.  
Since the first column you placed is still 
selected, i.e. displayed in green, easyBoard 
automatically knows where the next and next 

but one column belongs. You can therefore double-click as often as you like until you have placed all 
the columns for your shelf. The last column placed is always automatically selected. 
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In the current case, we want to create a shelf consisting of two units, it means that you 
also have to double-click three times on the columns entry to create a 2-segment shelf (3 
columns are needed). 

 

To see all placed columns in the center of the screen, click the Reset Position 
icon in the upper left corner. 
 
 
 

 

 

You can clearly see that the last column is displayed in green and is therefore selected.  

You could now place further columns by double-clicking and the last column will always 
be selected and the Distance Manager will always ensure the correct distance when 
placing the following column. 

 
Place back panels 
The next thing you need are the back panels, which have to be placed on the columns. As 
with all objects in easyBoard, you can of course do this manually by dragging and 
dropping with the mouse, the back panels know their place and know that they are only 
allowed on the columns. 
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However, easyBoard also offers a faster variant here.  

 

Go again briefly to the Distance manager and select the entry Go again briefly to the 
Distance manager and select the entry back panel Pos 0. 
    
Now click once on the first column that you have placed (you must briefly tell easyBoard 
where the next objects are to be placed). As soon as the column is marked green go to the 
backpanels in the libraries (for example the one with the ring perforation and the 
abbreviation RL) and double click on the 125cm wide and 40cm high backpanel.  
Immediately this is placed to your marked column at lowest position. 
After this is placed, double click on the entry in the library until the first column is filled 
with back wall parts. Now click on the next, i.e. the second placed column with the mouse 
and again double-click on the library entry until the column is filled. This is also done with 
each additional column. So you only have to mark where something should go and the 
double click does the rest. In the following the placement of the back walls once again in 
detail: 
 
Select the distance type once 
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a) Mark column by mouse click. 

 
 

b) Double-click on the entry of the back walls in the library.  
Double-click again for the second backwall, for the third and fourth back panel. 

 
 

c) Mark the next column with a mouse click and then double-click again to place the back 
panels. 

  
 
The walls are currently displayed in yellow because you have selected the line of the entry in 
the library. If you click there once on another entry, the back walls are displayed in their 
original color.  
This 'yellow marker function' is used to quickly and efficiently find a specific product or shelf 
part in its place on a full shelf. 
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By the way, once placed products or shelf parts are displayed in the library with a blue marker. 

Your finished shelf should look something like this after all the double-clicking: 
 

 
 
 

Place shelves 
The next step is to place the required shelves in the rack. Here, too, easyBoard helps with its internal 
grids. Go to the library with the shelves in the entry 3-Shelves/Shelves 125. 
Here you will find all existing shelf depths for the width of 125cm. Click on an entry (for example 
Shelf 125x57) and hold down the left mouse button. With the mouse button pressed, drag the 
desired shelf to the first column (the mouse pointer is the important position here, it must be 
brought to the column) and, without releasing the mouse button, move it up and down a few times 
before bringing it to the final desired position and releasing the mouse button there. You will notice 
that when you move it vertically, the floor knows exactly the right grid and locks every 5cm. 
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The first placed shelf is automatically marked green when you release the 
mouse button (in the following image at the lowest position in the first shelf 
segment). This gives you the possibility later to place products directly by 
double-clicking without having to select them again. 

 
 
After you have placed the first shelf, go directly back to the library and place a 
shelf with a depth of 47cm. Please place this shelf at a height of 65cm. 
How you can see a height in the shelf? Look at the numbers below the mouse 
pointer. There the X -value stands for horizontal position and for vertical 
position the Y-value is valid.  
So your Y-value should show 65.00 if everything is correct. 
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By the way, you can move a shelf to another position at any time.  
Simply click on the shelf and hold down the left mouse button.  
Now peat this game until all shelves are placed (view the library, select the shelf, drag the shelf to the 
shelf with the left mouse button pressed and release the mouse button at the desired position).   
Tip: The position where you place is always also the position of the mouse pointer. This must be 
moved up and down on the corresponding column in order to move the shelf along the column grid. 
 
Copy placed merchandise supports 
But placing more shelves with the same measurement is even faster:  
If you click on the shelf you just placed at a height of 50cm, hold down the CTRL key and now drag 
the shelf upwards while holding down the left mouse button, you will see how the previous shelf is 
automatically copied and can be placed in a new location.   
 
In the end, your shelf should look something like this: 

 
 
If you look at the picture above, you will surely notice that our shelf stands diagonally into the room 
and not flat from the front as you see it. 
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View project in 3D 
As you know easyboard can be 3D at any time. 

There is a button at the top of the Edit menu (which should currently be visible on your computer) 
that contains an icon with a cube and the label 3D: 
 

 

If you click on them and then move the mouse pointer to the center of your 
shelf (one of the back panels or a shelf should be displayed in green) hold down 
the right mouse button and move the mouse from right to left. 
 
Back to placement.  
You are now missing a few products to further complete the shelf.    First, we 
switch back from the 3D view to the 2D view. Instead of the 3D cube, the 
button is now shown with a rounded square and labeled 2D.  
Click on it and the shelf presents itself centrally and again in the 2D view. 
 

  
 
Place products on shelves 
To do this, we will switch from the library of trays to the library of products. As 
shown at the beginning, you just need to click on the icon for it (to the left of 
the library of trays) and your products will be available for placement. 
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In principle, the way of working with the products in the library is the same as with the product 
carriers: 
- Open the library by double-clicking 
- Select the product and move it to the shelf with the left mouse button pressed. 
- Alternatively, click on the shelf once with the left mouse button and double-click on the desired     
product to place it. 
 
But let's take it one step at a time: 
Go to the product library and click on a product there. 
 

 (alternatively to the selection of products in the 
library you can also use the search window placed 
above the libraries to find search window above the 
libraries, you can enter an article number enter) 

 
Hold down the left mouse button and drag it with the mouse onto one of the previously placed 
shelves. Make sure that the mouse pointer is guided to the upper edge of the shelf (easyBoard 
recognizes where a product is to go).  
You will see how the product snaps onto the floor and stands up. 
 

You have already seen another and perhaps even 
faster way of placing products in the product carriers.  
Selecting an object and then placing it by double-
clicking on it. This is also possible with products. Click 
on a placed shelf and then double-click on a product in 
the library. The product places itself immediately and 
left-aligned on the selected shelf. As long as this shelf 
remains selected (only if you click in the 3D window 
on another place or another object the selection is 
removed) you can double-click on further products. If 

the shelf is full, click on the next one and the double-click game with the products continues. 
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Tip: If you have placed products manually and by dragging them in with the mouse, there is no 
automatic left-justification. However, this can easily be made up for. Click on the shelf with the left 
mouse button and it will be highlighted in green. Now click on the same shelf with the right mouse 
button.  A context menu will open that offers the desired left-alignment (and other options like right-
aligned, spread, etc.). Click the option again with the left mouse button and you can see how all 
placed products are immediately left-aligned. 
 

 
 

Place products with hooks  
The next step is to place products that are 
hung on a hook. easyBoard also makes this 
easy and efficient. To do this, briefly switch to 
the goods carrier libraries and select a 
suitable one for your hangings in the library '5 
- Hooks'. Click on it with the right mouse 
button and select the lower option 'Standard 
hook'. Now this hook is selected for 
everything you want to hang in this project. 
This is valid until you set another hook as 
default.  
 

By the way, easyBoard remembers this setting as soon as the project is saved.  
If you reopen and edit the project at a later time, this check mark is automatically set again. 
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After selecting the default hook, switch back to the product libraries and drag a product onto the 
perforated wall (the product must have the 'hanging' property).  
Automatically, when you let go of the product, a hook will be placed and the product will be  
and, depending on the setting, the hook is filled (documentation on placing products). 
 

 
 
Here is an example of a stocked shelf: 
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Printout options  
When you have finished working on your project, it's time to share the overall result with your client.  
You can do this by printing it out or saving it to a PDF document.  
easyBoard has a central print menu for this purpose for all output options around a project. 
Simply click on the 'Print' button at the top left. 
(Alternatively, you can also use the key combination CTRL + P). 
 
You will now be taken to the easyBoard print center: 
 

 
 

Options 
The window is divided into logically arranged areas that contain 
the individual options for you. 
In the Options area, right at the top left, you select how the 
shelf is to be graphically brought to paper or PDF.  
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Print type 
 3D screen, prints the view that you have stored in the settings under Project (menu bar), 

Settings, Print. 

 
 

 
 Planogram – a 2D view of the complete project. 

 
In addition, you can also select the top view here.  
(e.g. if you have created a pallet line. To do this, select the respective 
goods carrier and press the 'V' key, a small menu opens and you can select 
the desired view. 

 
 Planogram by segment, prints a single page for each segment. The top view can also be 

switched on here. The number in the field next to it indicates how many segments / units 
should be printed on a printed page. For example, if you have 4 segments and enter the 
value 2, you will get two pages printed with two units per sheet. 
You per (because you may have rotated it in 3D view in the project screen). 

Graphic 
 Objects / textures - if this option is enabled, the graphics of products and product carriers 

will be printed as well. 
 Objects / Surfaces - prints a shelf only in the colors of objects, without graphics. 
 Wireframe model - prints the project in a wireframe view. 

 
Merchandise support only 
 Warrant ArtNo - prints a project without products, only with the used warrants and with the 

indication of the item numbers of the warrants. 
 Warp carrier PosNo - prints a project without products, only with the used warp carriers and 

with the indication of the item numbers of the warp carriers. 
 

 
 

http://www.easyboard.eu/


 

easyBoard GmbH - Ruhrstraße 49a - 41469 Neuss 
www.easyboard.eu – info@easyboard.eu 

The idea, concept and content of this document are the property of easyBoard GmbH and are subject to copyright under the German Civil Code.  Reproduction 
and/ or disclosure to third parties, in particular competitors, requires the express consent of easyBoard GmbH and will be prosecuted under civil and criminal 

law in the event of infringement. 

 
 
 Tray divider print position X 
 Tray divider position X from 0 to end 
 Position X as distances between the compartment dividers 

 
 
This option allows you to display the exact position of the placed dividers in cm when using dividers 
on shelves or wire baskets. An option that your store managers will appreciate very much. 
 
Shelf information 
If you activate this option, you can print out, for example, the printout of the height information of 
the placed shelves. (Selection: Position Y and shelves). 
 
Tip: Most options can be combined with each other. 
 

Produkt Informationen 
 
In the Product information area, you activate which article information is to be printed on the project 
image. For example, you can also print the corresponding item number on each article.  
 

By the way, all existing article data fields can be printed. 
The selection you get here in the print dialog depends 
on your program settings (see Tools - Settings - Print). 
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Printout forms 
The different printout options are clearly arranged. 
- Forms for printouts in graphical form can be found in the Planogram Printout area. 
- Forms for printouts of planograms with an integrated list of product carriers can be found in the 
Mixed Reports area. 
- Forms for reports and listing of placed products can be found in the Product Report section. 
- Forms for listing of used product carriers / shelf parts can be found in the area Reports of 
planogram product carriers. 
 
' 

 
 

Destination 
Here you define where or in which format your printout should be sent/saved.   
 

• Printers - here you can reach all printers 
installed on your device.  
• Preview - gives you a view of the print result      
 on the screen for the selected forms. 
• PDF - creates one or more PDF documents 
Excel – erzeugt ein Exceldokument aus den 
Reports. Only for forms from the areas Product 
Report and Reports of Planogram Merchandise 
Carriers. 
• CSV - creates a text document (with 

semicolon as separator) from the reports.  
Only for forms from the areas Product Report and Reports of Planogram Merchandise 
Carriers. 
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Preview 
The Preview function can be found under the 'Target' menu. 
If the checkmark is set here, clicking the OK button opens a new window with the preview of your 
project. 
 

 
 

Clicking the OK button starts the printout.  
The Cancel button closes the Print Center,  
without starting the printout. 
 
 
 
 
 
 

 

 

 

If you have any questions about the program or need further information, please write to: 
info@easyboard.eu 
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